
Chapter 1

The Excel 2013 User Experience

In This Chapter
▶ Getting familiar with the Excel 2013 program window and Backstage view

▶ Selecting commands from the Ribbon

▶ Customizing the Quick Access toolbar 

▶ Methods for starting Excel 2013

▶ Surfing an Excel 2013 worksheet and workbook

▶ Getting some help with using this program

Excel 2013, like Excel 2010 and Excel 2007 before it, relies upon a single 
strip at the top of the worksheet called the Ribbon that puts the bulk of 

the Excel commands you use at your fingertips at all times.

Add to the Ribbon a File tab and a Quick Access toolbar — along with a few 
remaining task panes (Clipboard, Clip Art, and Research) — and you end up 
with the handiest way to crunch your numbers, produce and print polished 
financial reports, as well as organize and chart your data. In other words, to 
do all the wonderful things for which you rely on Excel.

Best of all, the Excel 2013 user interface includes all sorts of graphical ele-
ments that make working on spreadsheets a lot faster and a great deal easier. 
Foremost is Live Preview that shows you how your actual worksheet data 
would appear in a particular font, table formatting, and so on before you 
actually select it. This Live Preview extends to the new Quick Analysis and 
Recommended PivotTables and Recommended Charts commands to enable 
you to preview your data in various formats before you apply them.

Additionally, Excel 2013 supports a Page Layout View that displays rulers 
and margins along with headers and footers for every worksheet with a Zoom 
slider at the bottom of the screen that enables you to zoom in and out on the 
spreadsheet data instantly. Finally, Excel 2013 is full of pop-up galleries that 
make spreadsheet formatting and charting a real breeze, especially in tandem 
with Live Preview.

05_9781118510124-ch01.indd   1105_9781118510124-ch01.indd   11 1/4/13   2:22 PM1/4/13   2:22 PM

CO
PYRIG

HTED
 M

ATERIA
L



12 Part I: Getting Started with Excel 2013 

Excel’s Ribbon User Interface
When you launch Excel 2013, the Start screen similar to the one shown in 
Figure 1-1 opens. Here you can start a new blank workbook by clicking the 
Blank workbook template, or you can select any of the other templates 
shown as the basis for your new spreadsheet. If none of the templates shown 
in the Start screen suits your needs, you can search for templates online. 
After you’ve worked with Excel for some time, the Start screen also displays a 
list of recently opened workbooks that you can reopen for further editing or 
printing.

When you select the Blank workbook template from the Excel 2013 Start 
screen, the program opens an initial worksheet (named Sheet1) in a new 
workbook file (named Book1) inside a program window like the one shown in 
Figure 1-2.

 

Figure 1-1: 
The Excel 
2013 Start 

screen 
enables you 

to open a 
new blank 
workbook, 
a recently 

opened 
workbook, 

or find a 
template to 
use as the 

basis for 
a new 

workbook.
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13 Chapter 1: The Excel 2013 User Experience

 

Figure 1-2: 
The Excel 

2013 
program 

window that 
appears 
immedi-

ately after 
selecting 
the Blank 

Workbook 
template in 

the opening 
screen.

 

The Excel program window containing this worksheet of the workbook con-
tains the following components:

 ✓ File button that when clicked opens the Backstage view — a menu on 
the left that contains all the document- and file-related commands, 
including Info, New, Open (selected by default when you first launch 
Excel), Save, Save As, Print, Share, Export, and Close. Additionally, at the 
bottom, there’s an Account option with User and Product information 
and an Options item that enables you to change many of Excel’s default 
settings. Note that you can exit the Backstage view and return to the 
normal worksheet view.

05_9781118510124-ch01.indd   1305_9781118510124-ch01.indd   13 1/4/13   2:22 PM1/4/13   2:22 PM



14 Part I: Getting Started with Excel 2013 

 ✓ Customizable Quick Access toolbar that contains buttons you can click 
to perform common tasks, such as saving your work and undoing and 
redoing edits. This toolbar is preceded by an Excel program button 
(sporting the Excel 2013 icon) with a drop-down menu of options that 
enable you to control the size and position of the Excel window and 
even close (exit) the program.

 ✓ Ribbon that contains the bulk of the Excel commands arranged into a 
series of tabs ranging from Home through View.

 ✓ Formula bar that displays the address of the current cell along with the 
contents of that cell.

 ✓ Worksheet area that contains the cells of the worksheet identified by 
column headings using letters along the top and row headings using 
numbers along the left edge; tabs for selecting new worksheets; a hori-
zontal scroll bar to move left and right through the sheet; and a vertical 
scroll bar to move up and down through the sheet.

 ✓ Status bar that keeps you informed of the program’s current mode and 
any special keys you engage and enables you to select a new worksheet 
view and to zoom in and out on the worksheet.

Going Backstage
To the immediate left of the Home tab on the Ribbon right below the Quick 
Access toolbar, you find the File button.

When you select File, the Backstage view opens. This view contains a menu 
similar to the one shown in Figure 1-3. When you open the Backstage view 
with the Info option selected, Excel displays at-a-glance stats about the work-
book file you have open and active in the program.

This information panel is divided into two panes. The pane on the left con-
tains large buttons that enable you to modify the workbook’s protection 
status, check the document before publishing, and manage its versions. The 
pane on the right contains a list of fields detailing the workbook’s various 
Document Properties, some of which you can change (such as Title, Tags, 
Categories, Author, and Last Modified By), and many of which you can’t 
(such as Size, Last Modified, Created, and so forth).

Below the Info option, you find the commands (New, Open, Save, Save As, 
Print, Share, Export, and Close) you commonly need for working with Excel 
workbook files. Near the bottom, the File tab contains an Account option 
that, when selected, displays an Account panel in the Backstage view. This 
panel displays user, connection, and Microsoft Office account information. 
Below the Account menu item, you find options that you can select to change 
the program’s settings.
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Figure 1-3: 
Open 

Backstage 
view to get 

at-a-glance 
information 

about the 
current file, 

access all 
file-related 

commands, 
and modify 

the program 
options.

 

 Select the Open option to open an Excel workbook you’ve worked on of late 
for more editing. When you select Open, Excel displays a panel with a list of all 
the workbook files recently opened in the program. To re-open a particular file 
for editing, all you do is click its filename in this list.

 To close the Backstage view and return to the normal worksheet view, you 
select the Back button at the very top of the menu or simply press Esc on your 
keyboard.

Using the Excel Ribbon
The Ribbon (shown in Figure 1-4) groups the most commonly used options 
needed to perform particular types of Excel tasks.
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16 Part I: Getting Started with Excel 2013 

 

Figure 1-4: 
Excel’s 
Ribbon 

consists 
of a series 

of tabs 
containing 
command 

buttons 
arranged 

into differ-
ent groups.

 

To do this, the Ribbon uses the following components:

 ✓ Tabs for each of Excel’s main tasks that bring together and display all 
the commands commonly needed to perform that core task.

 ✓ Groups that organize related command buttons into subtasks normally 
performed as part of the tab’s larger core task.

 ✓ Command buttons within each group that you select to perform a par-
ticular action or to open a gallery from which you can click a particular 
thumbnail. Note: Many command buttons on certain tabs of the Ribbon 
are organized into mini-toolbars with related settings.

 ✓ Dialog Box launcher in the lower-right corner of certain groups that 
opens a dialog box containing a bunch of additional options you can 
select.

 To display more of the Worksheet area in the program window, collapse the 
Ribbon so that only its tabs are displayed by simply clicking the Collapse the 
Ribbon button on the right side above the vertical scroll bar. You can also 
double-click (or double-tap on a touchscreen) any one of the Ribbon’s tabs, 
or press Ctrl+F1 on your keyboard. To once again pin the Ribbon in place so 
that all the command buttons on each of its tabs are always displayed in the 
program window, double-click (or double-tap) any one of the tabs, or press 
Ctrl+F1 a second time. You can also do this by selecting the Pin the Ribbon 
button (whose icon looks just like a pin) that replaces the Unpin the Ribbon 
button and appears whenever you temporarily activate a tab to use its com-
mand buttons.
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17 Chapter 1: The Excel 2013 User Experience

 When you work in Excel with the Ribbon collapsed, the Ribbon expands each 
time you activate one of its tabs to show its command buttons, but that tab 
stays open only until you select one of the command buttons or select an ele-
ment in the worksheet. The moment you select a command button, Excel 
immediately minimizes the Ribbon again and just displays its tabs. Note that 
you can also use the Show Tabs and Show Tabs and Commands options on 
the Ribbon Display Options button’s drop-down menu to switch between col-
lapsing the Ribbon to its tabs and restoring its commands again.

Keeping tabs on the Ribbon
The first time you launch a new workbook in Excel 2013, its Ribbon contains 
the following tabs from left to right:

 ✓ Home tab with the command buttons normally used when creating, for-
matting, and editing a spreadsheet, arranged into the Clipboard, Font, 
Alignment, Number, Styles, Cells, and Editing groups.

 ✓ Insert tab with the command buttons normally used when adding par-
ticular elements (including graphics, PivotTables, charts, hyperlinks, 
and headers and footers) to a spreadsheet, arranged into the Tables, 
Illustrations, Apps, Charts, Reports, Sparklines, Filter, Links, Text, and 
Symbols groups.

 ✓ Page Layout tab with the command buttons normally used when pre-
paring a spreadsheet for printing or re-ordering graphics on the sheet, 
arranged into the Themes, Page Setup, Scale to Fit, Sheet Options, and 
Arrange groups.

 ✓ Formulas tab with the command buttons normally used when adding 
formulas and functions to a spreadsheet or checking a worksheet for 
formula errors, arranged into the Function Library, Defined Names, 
Formula Auditing, and Calculation groups. Note: This tab also contains 
a Solutions group when you activate certain add-in programs, such as 
Analysis ToolPak and Euro Currency Tools. See Chapter 12 for more on 
using Excel add-in programs.

 ✓ Data tab with the command buttons normally used when importing, 
querying, outlining, and subtotaling the data placed into a worksheet’s 
data list, arranged into the Get External Data, Connections, Sort & Filter, 
Data Tools, and Outline groups. Note: This tab also contains an Analysis 
group when you activate add-ins, such as Analysis ToolPak and Solver. 
See Chapter 12 for more on Excel add-ins.
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 ✓ Review tab with the command buttons normally used when proofing, 
protecting, and marking up a spreadsheet for review by others, arranged 
into the Proofing, Language, Comments, and Changes groups. Note: 
This tab also contains an Ink group with a sole Start Inking button when 
you’re running Office 2013 on a device with a touchscreen such as a 
Tablet PC or a computer equipped with a digital ink tablet.

 ✓ View tab with the command buttons normally used when changing the 
display of the Worksheet area and the data it contains, arranged into the 
Workbook Views, Show, Zoom, Window, and Macros groups.

 In addition to these standard seven tabs, Excel has an eighth, optional 
Developer tab that you can add to the Ribbon if you do a lot of work with 
macros and XML files. See Chapter 12 for more on the Developer tab. If you 
are running a version of Excel 2013 with the PowerPivot add-in installed, a 
PowerPivot tab appears near the end of the Ribbon.

Although these standard tabs are the ones you always see on the Ribbon 
when it’s displayed in Excel, they aren’t the only things that can appear in 
this area. Excel can display contextual tools when you’re working with a 
particular object that you select in the worksheet, such as a graphic image 
you’ve added or a chart or PivotTable you’ve created. The name of the con-
textual tool for the selected object appears immediately above the tab or 
tabs associated with the tools.

For example, Figure 1-5 shows a worksheet after you click the embedded 
chart to select it. As you can see, doing this adds the contextual tool called 
Chart Tools to the very end of the Ribbon. The Chart Tools contextual tool 
has its two tabs: Design (selected) and Format. Note, too, that the command 
buttons on the Design tab are arranged into the groups Chart Layouts, Chart 
Styles, Data, Type, and Location.

 The moment you deselect the object (usually by clicking somewhere outside 
the object’s boundaries), the contextual tool for that object and all its tabs 
immediately disappear from the Ribbon, leaving only the regular tabs — 
Home, Insert, Page Layout, Formulas, Data, Review, and View — displayed.

Selecting commands with mouse and keyboard
Because Excel 2013 runs on many different types of devices, the most effi-
cient means of selecting Ribbon commands depends not only on the device 
on which you’re running the program, but also on the way that device is 
equipped.
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Figure 1-5: 
When you 

select 
certain 
objects 

in the 
worksheet, 
Excel adds 
contextual 

tools to 
the Ribbon 

with their 
own tabs, 

groups, and 
command 

buttons.
 

For example, when I run Excel 2013 on my Windows 8 tablet in its dock 
equipped with a physical keyboard and with my optical wireless mouse con-
nected, I select commands from the Excel Ribbon more or less the same way 
I do when running Excel on my Windows desktop computer equipped with a 
stand-alone physical keyboard and mouse or laptop computer with its built-
in physical keyboard and track pad. 

However, when I run Excel 2013 on my Windows 8 tablet without access to 
the dock with its physical keyboard and mouse, I am limited to selecting 
Ribbon commands directly on the touchscreen with my finger or stylus.

The most direct method for selecting Ribbon commands equipped with a 
physical keyboard and mouse is to click the tab that contains the command 
button you want and then click that button in its group. For example, to 
insert an online image into your spreadsheet, you click the Insert tab and 
then click the Illustrations button followed by the Online Pictures button to 
open the Insert Pictures dialog box.
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The easiest method for selecting commands on the Ribbon — if you know 
your keyboard at all well — is to press the keyboard’s Alt key and then type 
the letter of the hot key that appears on the tab you want to select. Excel then 
displays all the command button hot keys next to their buttons, along with the 
hot keys for the dialog box launchers in any group on that tab. To select a com-
mand button or dialog box launcher, simply type its hot key letter.

If you know the old Excel shortcut keys from versions prior to Excel 2007, 
you can still use them. For example, instead of going through the rigmarole of 
pressing Alt+HCC to copy a cell selection to the Windows Clipboard and then 
Alt+HVP to paste it elsewhere in the sheet, you can still press Ctrl+C to copy 
the selection and then press Ctrl+V when you’re ready to paste it. 

Selecting commands by touch
Before trying to select Excel Ribbon commands by touch, however, you defi-
nitely want to turn on Touch mode in Excel 2013. When you do this, Excel 
spreads out the command buttons on the Ribbon tabs by putting more space 
around them, making it more likely you’ll actually select the command button 
you’re tapping with your finger (or even a more slender stylus) instead of one 
right next to it. (This is a particular problem with the command buttons in 
the Font group on the Home tab that enable you to add different attributes 
to cell entries such as bold, italic, or underlining: They are so close together 
when Touch mode is off that they are almost impossible to correctly select 
by touch.)

What click and drag means on your device
Given all the different choices for selecting stuff 
in Excel, you need to be aware of a few click-
and-drag conventions used throughout this 
book. When I say click something (a command 
button, cell, or whatever), this means click the 
primary mouse button (the left one unless you 
change it) on a physical mouse or tap with your 
finger or a stylus on a touchscreen. When I say 
double-click something, this means click the 
primary button twice in rapid succession on a 
physical mouse and double tap the object with 
your finger or stylus. When I say right-click, 
this means click with the secondary button 
(the right-hand button unless you change it) on 

a physical mouse or tap the object and keep 
your finger or stylus on the touchscreen until 
the context menu or pop-up gallery or whatever 
appears. Finally, when I say drag through a cell 
selection, with a physical mouse this means 
click the cell and then hold down the primary 
mouse button as you swipe and then release 
the button when the selection is made. On a 
touchscreen, you tapthe cell to make the selec-
tion handles appear (the circles at the upper-
left and lower-right corners of the cell) and then 
use your finger or stylus to drag the selection 
handle through the cells..
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To do this, simply tap the Touch/Mouse Mode button that appears near 
the end of the Quick Access toolbar sandwiched between the Redo and 
Customize Quick Access Toolbar button. When you tap this button a drop-
down menu with two options, Mouse and Touch appear. Tap the Touch 
option to put your touchscreen tablet or laptop into Touch mode.

 Although the Touch/Mouse Mode button is automatically added to the Excel 
2013 Quick Access toolbar only when running the program on a tablet or per-
sonal computer equipped with a touchscreen, that doesn’t mean you can’t 
use it to switch between Touch mode (with more space between Ribbon com-
mand buttons) and Mouse mode on a standard computer without touchscreen 
technology. All you have to do is add the Touch/Mouse Mode button to the 
Quick Access toolbar (see “Customizing the Quick Access toolbar” that fol-
lows for details).

Customizing the Quick Access toolbar
When you start using Excel 2013, the Quick Access toolbar contains only the 
following few buttons:

 ✓ Save to save any changes made to the current workbook using the same 
filename, file format, and location

 ✓ Undo to undo the last editing, formatting, or layout change you made

 ✓ Redo to reapply the previous editing, formatting, or layout change that 
you just removed with the Undo button

 ✓ Touch/Mouse Mode (tablets and computers with touchscreens only) to 
place more space around Ribbon command buttons to make it easier to 
select commands with your finger or stylus

The Quick Access toolbar is very customizable because Excel makes it easy 
to add any Ribbon command to it. Moreover, you’re not restricted to adding 
buttons for just the commands on the Ribbon; you can add any Excel com-
mand you want to the toolbar, even the obscure ones that don’t rate an 
appearance on any of its tabs.

 By default, the Quick Access toolbar appears above the Ribbon tabs immedi-
ately to the right of the Excel program button (used to resize the workbook 
window or quit the program). To display the toolbar beneath the Ribbon 
immediately above the Formula bar, click the Customize Quick Access Toolbar 
button (the drop-down button to the right of the toolbar with a horizontal bar 
above a down-pointing triangle) and then click Show Below the Ribbon on 
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its drop-down menu. You will definitely want to make this change if you start 
adding more than just a few extra buttons to the toolbar. That way, the grow-
ing Quick Access toolbar doesn’t start crowding the name of the current work-
book that appears to the toolbar’s right.

Adding Customize Quick Access Toolbar’s menu commands
When you click the Customize Quick Access Toolbar button, a drop-down 
menu appears containing the following commands:

 ✓ New to open a new workbook

 ✓ Open to display the Open dialog box for opening an existing workbook

 ✓ Save to save changes to your current workbook

 ✓ Email to open your mail

 ✓ Quick Print to send the current worksheet to your default printer

 ✓ Print Preview and Print to open the Print panel in Backstage view with 
a preview of the current worksheet in the right pane

 ✓ Spelling to check the current worksheet for spelling errors

 ✓ Undo to undo your latest worksheet edit

 ✓ Redo to reapply the last edit that you removed with Undo

 ✓ Sort Ascending to sort the current cell selection or column in A to 
Z alphabetical order, lowest to highest numerical order, or oldest to 
newest date order

 ✓ Sort Descending to sort the current cell selection or column in Z to 
A alphabetical order, highest to lowest numerical order, or newest to 
oldest date order

 ✓ Touch /Mouse Mode to switch in and out of Touch mode that adds 
extra space around the command buttons on the individual Ribbon tabs 
to make them easier to select on a touchscreen device regardless of 
whether you tap with your finger or a stylus

When you open this menu, only the Save, Undo, and Redo options are the 
ones selected (indicated by the check marks); therefore, these buttons are 
the only buttons to appear on the Quick Access toolbar. To add any of the 
other commands on this menu to the toolbar, you simply click the option 
on the drop-down menu. Excel then adds a button for that command to the 
end of the Quick Access toolbar (and a check mark to its option on the drop-
down menu).
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To remove a command button that you add to the Quick Access toolbar in 
this manner, click the option a second time on the Customize Quick Access 
Toolbar button’s drop-down menu. Excel removes its command button from 
the toolbar and the check mark from its option on the drop-down menu.

Adding Ribbon commands
To add a Ribbon command to the Quick Access toolbar, open the command 
button’s shortcut menu (right-click with a mouse or tap and hold on a touch-
screen) and then select the Add to Quick Access Toolbar menu item. Excel 
then immediately adds the selected Ribbon command button to the very end 
of the Quick Access toolbar, immediately in front of the Customize Quick 
Access Toolbar button.

If you want to move the command button to a new location on the Quick 
Access toolbar or group it with other buttons on the toolbar, select the 
Customize Quick Access Toolbar button followed by the More Commands 
option near the bottom of its drop-down menu.

Excel then opens the Excel Options dialog box with the Quick Access Toolbar 
tab selected (similar to the one shown in Figure 1-6). On the right side of the 
dialog box, Excel shows all the buttons added to the Quick Access toolbar. 
The order in which they appear from left to right on the toolbar corresponds 
to the top-down order in the list box.

 

Figure 1-6: 
Use the 

buttons on 
the Quick 

Access 
Toolbar tab 
of the Excel 

Options 
dialog box 

to customize 
the appear-

ance of 
the Quick 

Access 
toolbar.
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To reposition a particular button on the toolbar, select it in the list box on 
the right and then select either the Move Up button (the one with the black 
triangle pointing upward) or the Move Down button (the one with the black 
triangle pointing downward) until the button is promoted or demoted to the 
desired position on the toolbar.

 You can add a pair of vertical separators to the toolbar to group related 
buttons. To do this, select the <Separator> option in the list box on the left 
followed by the Add button twice. Then, select the Move Up or Move Down 
button to position one of the two separators at the beginning of the group and 
the other at the end.

To remove a button you’ve added, open the Quick Access toolbar’s short-
cut menu (right-click or tap and hold on a touchscreen) and then select the 
Remove from Quick Access Toolbar option.

Adding non-Ribbon commands to the Quick Access toolbar
You can also use the options on the Quick Access Toolbar tab of the Excel 
Options dialog box (refer to Figure 1-6) to add a button for any Excel com-
mand even if it isn’t one of those displayed on the tabs of the Ribbon:

 1. Select the type of command you want to add to the Quick Access tool-
bar in the Choose Commands From drop-down list box.

  The types of commands include the Popular Commands pull-down menu 
(the default) as well as each of the tabs that appear on the Ribbon. To 
display only the commands that are not displayed on the Ribbon, select 
Commands Not in the Ribbon near the top of the drop-down list. To dis-
play a complete list of the Excel commands, select All Commands near 
the top of the drop-down list.

 2. Select the command button you want to add to the Quick Access tool-
bar in the list box on the left.

 3. Click the Add button to add the command button to the bottom of the 
list box on the right.

 4. (Optional) To reposition the newly added command button so that it 
isn’t the last one on the toolbar, click the Move Up button until it’s in 
the desired position.

 5. Click OK to close the Excel Options dialog box.

 If you’ve created favorite macros (see Chapter 12) that you routinely use and 
want to be able to run directly from the Quick Access toolbar, select Macros 
in the Choose Commands From drop-down list box in the Excel Options dialog 
box and then click the name of the macro to add followed by the Add button.
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Having fun with the Formula bar
The Formula bar displays the cell address (determined by a column letter(s) 
followed by a row number) and the contents of the current cell. For example, 
cell A1 is the first cell of each worksheet at the intersection of column A and 
row 1; cell XFD1048576 is the last cell of each worksheet at the intersection 
of column XFD and row 1048576. The type of entry you make determines the 
contents of the current cell: text or numbers, for example, if you enter a head-
ing or particular value, or the details of a formula if you enter a calculation.

The Formula bar has three sections:

 ✓ Name box: The left-most section that displays the address of the current 
cell address.

 ✓ Formula bar buttons: The second, middle section that appears as a 
rather nondescript button displaying only an indented circle on the left 
(used to narrow or widen the Name box) and the Insert Function button 
(labeled fx) on the right. When you start making or editing a cell entry, 
Cancel (an X) and Enter (a check mark) buttons appear between them.

 ✓ Cell contents: The third, right-most white area to the immediate right 
of the Insert Function button takes up the rest of the bar and expands 
as necessary to display really long cell entries that won’t fit in the 
normal area.

 The cell contents section of the Formula bar is important because it always 
shows you the contents of the cell even when the worksheet does not. (When 
you’re dealing with a formula, Excel displays only the calculated result in the 
cell in the worksheet and not the formula by which that result is derived.) 
Additionally, you can edit the contents of the cell in this area at any time. 
Similarly, when the cell contents area is blank, you know that the cell is empty 
as well.

How you assign 26 letters to 16,384 columns
When it comes to labeling the 16,384 columns 
of an Excel 2013 worksheet, our alphabet with 
its measly 26 letters is simply not up to the task. 
To make up the difference, Excel doubles the 
letters in the cell’s column reference so that 
column AA follows column Z (after which you 
find column AB, AC, and so on) and then triples 

them so that column AAA follows column ZZ 
(after which you get column AAB, AAC, and the 
like). At the end of this letter tripling, the 16,384th 
and last column of the worksheet ends up being 
XFD so that the last cell in the 1,048,576th row 
has the cell address XFD1048576!
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What to do in the Worksheet area
The Worksheet area is where most of the Excel spreadsheet action takes 
place because it’s the place that displays the cells in different sections of the 
current worksheet and it’s right inside the cells that you do all your spread-
sheet data entry and formatting, not to mention a great deal of your editing.

 To enter or edit data in a cell, that cell must be current. Excel indicates that a 
cell is current in three ways:

 ✓ The cell cursor — the dark green border surrounding the cell’s entire 
perimeter — appears in the cell.

 ✓ The address of the cell appears in the Name box of the Formula bar.

 ✓ The cell’s column letter(s) and row number are shaded in the column 
headings and row headings that appear at the top and left of the 
Worksheet area, respectively.

Moving around the worksheet
An Excel worksheet contains far too many columns and rows for all a work-
sheet’s cells to be displayed at one time regardless of how large your com-
puter’s monitor screen is or how high the screen resolution. (After all, we’re 
talking 17,179,869,184 cells total!) Therefore, Excel offers many methods for 
moving the cell cursor around the worksheet to the cell where you want to 
enter new data or edit existing data:

 ✓ Click the desired cell — assuming that the cell is displayed within the 
section of the sheet visible in the Worksheet area — either by clicking it 
with your mouse or tapping it on your touchscreen.

  Click the Name box, then type the address of the desired cell and press 
the Enter key.

 ✓ Press F5 to open the Go To dialog box, type the address of the desired 
cell into its Reference text box, and then click OK.

 ✓ Use the cursor keys, as shown in Table 1-1 to move the cell cursor to the 
desired cell.

 ✓ Use the horizontal and vertical buttons located at the ends of the scroll 
bars found at the bottom and right edge of the Worksheet area to move 
to the part of the worksheet that contains the desired cell and then click 
or tap the cell to put the cell cursor in it.
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Keystroke shortcuts for moving the cell cursor
Excel offers a wide variety of keystrokes for moving the cell cursor to a 
new cell. When you use one of these keystrokes, the program automatically 
scrolls a new part of the worksheet into view, if this is required to move the 
cell pointer. In Table 1-1, I summarize these keystrokes, including how far 
each one moves the cell pointer from its starting position.

Table 1-1 Keystrokes for Moving the Cell Cursor

Keystroke Where the Cell Cursor Moves

→ or Tab Cell to the immediate right.

← or Shift+Tab Cell to the immediate left.

↑ Cell up one row.

↓ Cell down one row.

Home Cell in Column A of the current row.

Ctrl+Home First cell (A1) of the worksheet.

Ctrl+End or End, 
Home

Cell in the worksheet at the intersection of the last column 
that has data in it and the last row that has data in it (that is, 
the last cell of the so-called active area of the worksheet).

Page Up Cell one full screen up in the same column.

Page Down Cell one full screen down in the same column.

Ctrl+→ or End, → First occupied cell to the right in the same row that is either 
preceded or followed by a blank cell. If no cell is occupied, 
the pointer goes to the cell at the very end of the row.

Ctrl+← or End, ← First occupied cell to the left in the same row that is either 
preceded or followed by a blank cell. If no cell is occupied, 
the pointer goes to the cell at the very beginning of the row.

Ctrl+↑ or End, ↑ First occupied cell above in the same column that is either 
preceded or followed by a blank cell. If no cell is occupied, 
the pointer goes to the cell at the very top of the column.

Ctrl+↓ or End, ↓ First occupied cell below in the same column that is either 
preceded or followed by a blank cell. If no cell is occupied, 
the pointer goes to the cell at the very bottom of the column.

Ctrl+Page Down The cell pointer’s location in the next worksheet of that 
workbook.

Ctrl+Page Up The cell pointer’s location in the previous worksheet of 
that workbook.

Note: In the case of those keystrokes that use arrow keys, you must either use the arrows on the 
cursor keypad or else have the Num Lock disengaged on the numeric keypad of your keyboard. 
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The keystrokes that combine the Ctrl or End key with an arrow key listed in 
Table 1-1 are among the most helpful for moving quickly from one edge to the 
other in large tables of cell entries or for moving from table to table in a sec-
tion of a worksheet with many blocks of cells.

When you use Ctrl and an arrow key to move from edge to edge in a table or 
between tables in a worksheet, you hold down Ctrl while you press one of the 
four arrow keys (indicated by the + symbol in keystrokes, such as Ctrl+→).

When you use End and an arrow-key alternative, you must press and then 
release the End key before you press the arrow key (indicated by the comma 
in keystrokes, such as End, →). Pressing and releasing the End key causes the 
End Mode indicator to appear on the Status bar. This is your sign that Excel 
is ready for you to press one of the four arrow keys.

Because you can keep the Ctrl key depressed while you press the different 
arrow keys that you need to use, the Ctrl-plus-arrow-key method provides a 
more fluid method for navigating blocks of cells than the End-then-arrow-key 
method.

 You can use the Scroll Lock key to “freeze” the position of the cell pointer in 
the worksheet so that you can scroll new areas of the worksheet in view with 
keystrokes, such as PgUp (Page Up) and PgDn (Page Down), without changing 
the cell pointer’s original position (in essence, making these keystrokes work 
in the same manner as the scroll bars).

After engaging Scroll Lock, when you scroll the worksheet with the keyboard, 
Excel does not select a new cell while it brings a new section of the work-
sheet into view. To “unfreeze” the cell pointer when scrolling the worksheet 
via the keyboard, you just press the Scroll Lock key again.

Tips on using the Touch keyboard
If you’re running Excel 2013 on a device that lacks any kind of physical key-
board, you need to open the Touch keyboard and use it both to input your 
spreadsheet data..

To open the Touch keyboard, simply tap the Touch Keyboard button that 
appears on the right side of your Windows 7 or 8 taskbar. Doing this displays 
the Touch keyboard floating undocked at the bottom of the Excel program 
window.

To dock the Touch keyboard beneath the Excel 2013 program window, 
simply click the Dock button that appears to the immediate left of the Close 
button in the upper-right corner of the keyboard. Figure 1-7 shows you how 
your touchscreen looks after docking the Windows 8 Touch keyboard.
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Figure 1-7: 
Windows 

8 touch-
screen after 

displaying 
and docking 

the Touch 
keyboard 

beneath the 
Excel 2013 

program 
window.

 

As shown in this figure, when docked, the Windows 8 Touch keyboard 
remains completely separate from the Excel program window so that you still 
have access to all the cells in the current worksheet when doing your data 
entry. The Windows 8 Touch keyboard is limited mostly to letter keys above 
a spacebar with a few punctuation symbols (apostrophe, comma, period, and 
question mark). This keyboard also sports the following special keys:

 ✓ Backspace key (marked with the x in the shape pointing left) to delete 
characters to the immediate left when entering or editing a cell entry

 ✓ Enter key to complete an entry in the current cell and move the cursor 
down one row in the same column

 ✓ Shift keys (with an arrow pointing upward) to enter capital letters in a 
cell entry

 ✓ Numeric key (with the &123) to switch to the Touch keyboard so that it 
displays a numeric keyboard with a Tab key and extensive punctuation 
used in entering numeric data in a cell (tap the &123 key a second time 
to return to the standard QWERTY letter arrangement)
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 ✓ Ctrl key to run macros to which you’ve assigned letter keys (see Chapter 
12 for details) or to combine with the Left arrow or Right arrow key to 
jump the cursor to the cell in the last and first column of the current 
row, respectively

 ✓ Emoticon key (with that awful smiley face icon) to switch to a bunch of 
emoticons that you can enter into a cell entry (tap the Emoticon key a 
second time to return to standard QWERTY letter arrangement)

 ✓ Left arrow (with the < symbol) to move the cell cursor one cell to the 
immediate right and complete any cell entry in progress

 ✓ Right arrow (with the > symbol) to move the cell cursor one cell to the 
immediate left and complete any cell entry in progress

When you finish entering your worksheet data with the Windows 8 Touch 
keyboard, you can close it and return to the normal full screen view of the 
Excel program window by tapping the Close button.

 The Windows 8 Touch keyboard supports a split-keyboard arrangement that 
separates the QWERTY letter keys into two banks on the left and right with 
a ten-key numeric keypad in the middle. The drawback is that the individual 
keys are smaller than the normal, non-split arrangement and can be harder 
to select with your finger or stylus. The big bonus is that you can enter both 
numbers and text into the cells of your worksheet without having to switch 
back and forth between the QWERTY letter and numeric key arrangements. To 
switch to the split-keyboard arrangement, tap the Keyboard button in the very 
lower-right corner of the Touch keyboard (to the immediate right of the Right 
arrow key) and then tap second button from the left (that shows a gap in the 
keyboard icon) in the pop-up menu that appears.

Tips on using the scroll bars
To understand how scrolling works in Excel, imagine its humongous work-
sheet as a papyrus scroll attached to rollers on the left and right. To bring 
into view a section of papyrus hidden on the right, you crank the left roller 
until the section with the cells that you want to see appears. Likewise, to 
scroll into view a worksheet section hidden on the left, you crank the right 
roller until the section of cells appears.

You can use the horizontal scroll bar at the bottom of the Worksheet area 
to scroll back and forth through the columns of a worksheet and the verti-
cal scroll bar to scroll up and down through its rows. To scroll a column or 
a row at a time in a particular direction, select the appropriate scroll arrow 
at the ends of the scroll bar. To jump immediately back to the originally dis-
played area of the worksheet after scrolling through single columns or rows 
in this fashion, simply click (tap on a touchscreen) the area in the scroll bar 
that now appears in front of or after the scroll bar. 
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You can resize the horizontal scroll bar making it wider or narrower by drag-
ging the button that appears to the immediate left of its left scroll arrow. Just 
keep in mind when working in a workbook that contains a whole bunch of 
worksheets that widening the horizontal scroll bar can hide the display of the 
workbook’s later sheet tabs.

 To scroll very quickly through columns or rows of the worksheet when you 
have a physical keyboard available, hold down the Shift key and then drag 
the scroll button in the appropriate direction within the scroll bar until the 
columns or rows that you want to see appear on the screen in the Worksheet 
area. When you hold down the Shift key while you scroll, the scroll button 
within the scroll bar becomes skinny and a ScreenTip appears next to the 
scroll bar, keeping you informed of the letter(s) of the columns or the num-
bers of the rows that you’re whizzing through.

If you have a mouse and it’s equipped with a wheel, you can use it to scroll 
directly through the columns and rows of the worksheet without using the 
horizontal or vertical scroll bars. Simply position the white cross mouse 
pointer in the center of the Worksheet area and then hold down the wheel 
button of the mouse. When the mouse pointer changes to a four-pointed 
arrow with a black dot in its center, drag the mouse pointer in the appropri-
ate direction (left and right to scroll through columns or up and down to 
scroll through rows) until the desired column or row comes into view in the 
Worksheet area.

 On a touchscreen device, you can also scroll new parts of a worksheet into 
view simply by swiping with your finger or stylus to scroll (by dragging it on 
the screen). To scroll new worksheet columns on the right into view, you 
swipe right-to-left. To scroll new worksheet rows from below into view, swipe 
up, bottom to top. The force with which you slide determines how many col-
umns or rows you scroll through. To return previously displayed columns or 
rows into view, simply slide in the opposite direction: left to right to scroll col-
umns left and downward to scroll rows up.

 The only disadvantage to using the scroll bars to move around is that the 
scroll bars bring only new sections of the worksheet into view — they don’t 
actually change the position of the cell cursor. If you want to start making 
entries in the cells in a new area of the worksheet, you still have to remember 
to select the cell (by clicking it) or the group of cells (by dragging through 
them) where you want the data to appear before you begin entering the data.

Surfing the sheets in a workbook
Each new workbook you open in Excel 2013 contains a single blank work-
sheet with 16,384 columns and 1,048,576 rows (giving you a truly staggering 
17,179,869,184 blank cells!). But, that’s not all. If ever you need more 
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worksheets in your workbook, you can add them simply by clicking the New 
Sheet button (indicated by the plus sign in a circle) that appears to the imme-
diate right of the last visible tab (see callout in Figure 1-8) or by selecting 
Shift+F11.

 

Figure 1-8: 
The Sheet 
Tab scroll 

buttons, 
sheet tabs, 
Next sheet, 

Previous 
sheet, and 

New Sheet 
button 

enable you 
to activate 
your work-
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On the left side of the bottom of the Worksheet area, the Sheet Tab scroll but-
tons appear followed by the actual tabs for the worksheets in your workbook 
and the New Sheet button. To activate a worksheet for editing, you select it 
by clicking its sheet tab. Excel lets you know what sheet is active by display-
ing the sheet name in boldface type and underlining it to make its tab appear 
connected to the current sheet.

One reason for adding extra sheets to a workbook
You may wonder why anyone would ever need 
more than a single worksheet given just how 
many cells it already contains. The truth is that 
it’s all about how you choose to structure a par-
ticular spreadsheet rather than running out of 
places to put the data. For example, suppose 
that you need to create a workbook that con-
tains budgets for all the various departments in 
your corporation. You may decide to devote an 

individual worksheet to each department (with 
the actual budget spreadsheet tables laid out 
in the same manner on each sheet) rather than 
placing all the tables in different sections of the 
same sheet. Using this kind of one-sheet-per-
budget layout makes it much easier for you to find 
each budget, print each one as a separate page 
of a report, and, if ever necessary, to consolidate 
the data in a separate summary worksheet.
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 Don’t forget the Ctrl+Page Down and Ctrl+Page Up shortcut keys for selecting 
the next and previous sheet, respectively, in your workbook.

If your workbook contains too many sheets for all the tabs to be displayed at 
the bottom of the Worksheet area, use the Sheet Tab scroll buttons to bring 
new tabs into view (so that you can then click them to activate them). You 
click the Next Sheet button (the ellipsis or three periods to the left of the first 
visible sheet) to scroll the next hidden sheet tab into view or the Last Sheet 
button (the ellipsis or three periods to the left of the last visible sheet) to 
scroll the last group of completely or partially hidden tabs into view.

To scroll the very first worksheet in the workbook into view, you can hold 
down the Ctrl as you click the left-pointing Sheet Tab scroll button. To scroll 
the last sheet into view, you Ctrl+click the right-pointing scroll button. 

To display the Activate dialog box that lists all the sheets in the workbook 
from first to last, right-click either one of the Sheet Tab scroll buttons. You 
can then both scroll into view and click any of the sheets in the workbook 
simply by clicking its name in the Activate dialog followed by OK.

 On a touchscreen device, remember that the touch equivalent of a right-click 
with a mouse is to tap and press the graphic element on the screen — the 
Sheet Tab scroll button in this case — until a circle appears around your 
finger or stylus. When you then remove your finger or stylus from the screen, 
the shortcut menu or, in this case, dialog box associated with the graphic ele-
ment appears.

Showing off the Status bar
The Status bar is the last component at the very bottom of the Excel program 
window (see Figure 1-9). The Status bar contains the following:

 ✓ Mode indicator on the left that shows the current state of the Excel 
program (Ready, Edit, and so on) as well as any special keys that are 
engaged (Caps Lock, Num Lock, and Scroll Lock).

 ✓ AutoCalculate indicator that displays the average and sum of all the 
numerical entries in the current cell selection along with the count of 
every cell in the selection.

 ✓ Layout selector that enables you to select between three layouts for the 
Worksheet area: Normal, the default view that shows only the worksheet 
cells with the column and row headings; Page Layout View that adds 
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rulers, page margins, and shows page breaks for the worksheet; and 
Page Break Preview that enables you to adjust the paging of a report. 
(See Chapter 5 for details.)

 ✓ Zoom slider that enables you to zoom in and out on the cells in the 
Worksheet area by dragging the slider to the right or left, respectively.

 

Figure 1-9: 
The Status 
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 On a touchscreen device, you can work the Zoom slider by using the Pinch 
and Stretch gesture to increase and decrease the size of the cells displayed in 
your worksheet. As you stretch your thumb and forefinger apart, you zoom in 
on the worksheet and the Zoom slider moves to the right and the percentage 
increases. As you pinch your fingers together, you zoom out on the worksheet 
and the Zoom slider moves to the left and the percentage decreases.

 The Num Lock indicator on a physical keyboard equipped with a numeric 
keypad tells you that you can use the keypad to enter values in the worksheet. 
This keypad will most often be separate from the regular keyboard (on the 
right side if you’re using a separate keyboard) and embedded in keys on the 
right side of the keyboard on almost all laptop computers where the keyboard 
is built in to the computer.

Launching and Quitting Excel
Excel 2013 runs only under Windows 7 and the new Windows 8 operating 
system. This means that if your PC is running the old Vista or XP versions 
of Windows, you must upgrade before you can successfully install and run 
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Excel 2013. Because of the significant changes made to the user interface in 
Windows 8, the procedure for starting Excel 2013 on this operating system is 
quite a bit different from Windows 7.

Starting Excel from the Windows 8 
Start screen
When starting Excel 2013 from the Windows 8 Start screen, you simply select 
the Excel 2013 program tile either by clicking it if you have a mouse avail-
able or tapping it with your finger or stylus if you’re running Windows 8 on a 
touchscreen device.

If you can’t locate the Excel 2013 tile among those displayed on the Start 
screen, use the Search feature to find the application and pin it to the 
Windows 8 Start screen:

 1. From the Start screen, begin typing exc on your physical or virtual 
keyboard.

  Windows 8 displays Excel 2013 in the list of programs under Apps on the 
left side of the screen.

 2. Right-click the Excel 2013 button in the Apps list on the left side of 
the screen.

  On a touchscreen device, the equivalent to the right-click of the mouse 
is to tap and hold the Excel 2013 menu item until a circle appears around 
your finger or stylus. Then, when you remove the finger or stylus from 
the screen, the shortcut menu appears.

 3. Select the Pin to Start option in the menu bar that appears at the 
bottom of the screen.

After pinning an Excel 2013 tile to the Windows 8 Start screen, you can move 
it by dragging and dropping it in your desired block.

Starting Excel from the Windows 7 
Start menu
When starting Excel 2013 from the Windows 7 Start menu, you follow these 
simple steps:
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 1. Click the Start button on the Windows taskbar to open the Windows 
Start menu.

  To select the Start button on a touchscreen device with no mouse, you 
tap the button on the touchscreen.

 2. Select All Programs on the Start menu followed by the Microsoft 
Office 2013 and Excel 2013 option on the continuation menus.

You can use the Search Programs and Files search box on the Windows 7 
Start menu to locate Excel on your computer and launch the program in no 
time at all:

 1. Click the Start button on the Windows taskbar to open the Windows 
Start menu.

 2. Click in the Start menu’s search text box and type the letters exc to 
have Windows locate Microsoft Office Excel 2013 on your computer.

  If you’re using a device without a physical keyboard, double-tap the 
right edge of the virtual keyboard that appears on the left edge of the 
Windows Start menu and screen to make the entire keyboard appear 
and then tap out the letters exc.

 3. Select the Microsoft Excel 2013 option that now appears in the left 
Programs column on the Start menu.

Adding an Excel 2013 shortcut 
to your Windows 7 desktop
Some people prefer having the Excel program icon appear on the Windows 
desktop so that they can launch the program from the desktop by double-
clicking this program icon. To create an Excel 2013 program shortcut for 
your Windows 7 desktop, you follow these simple steps:

 1. Click the Windows Start button and then select the All Programs 
option on the Start menu.

  Windows 7 displays a new menu of program options on the Start menu.

 2. Select the Microsoft Office 2013 option on the Start menu.

  Windows displays a submenu listing all the Office 2013 programs 
installed on your device.

 3. Drag the Excel 2013 item from the Start menu to the Windows 7 desk-
top and drop it in the desired position.
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  As you drag the icon to the desktop, the screen tip “Move to Desktop” 
appears under the outline of the icon. When you drop the icon in 
place on the desktop, Windows adds an Excel 2013 shortcut icon that 
launches the program when you double-click it with a mouse or double-
tap it with your finger or a stylus on a touchscreen device.

Pinning Excel 2013 to your 
Windows 7 Start menu
If you use Excel all the time, you may want to make its program option a per-
manent part of the Windows 7 Start menu. To do this, you pin the program 
option to the Start menu:

 1. Click the Windows Start button and then select the All Programs 
option on the Start menu.

  Windows 7 displays a new menu of program options on their Start 
menus.

 2. Select the Microsoft Office 2013 option from the Start menu.

  Windows 7 displays a submenu listing the Office 2013 programs.

 3. Right-click Excel 2013 on the Windows continuation or submenu to 
open its shortcut menu.

  On a touchscreen device, the equivalent to the right-click of the mouse 
is to tap and hold the Excel 2013 menu item until a circle appears 
around your finger or stylus. Then, when you remove the finger or stylus 
from the screen, the shortcut menu appears.

 4. Select Pin to Start Menu on the shortcut menu.

 After pinning Excel in this manner, the Excel 2013 option always appears in 
the upper section of the left-hand column of the Windows Start menu, and you 
can then launch Excel simply by opening the Windows Start button and then 
selecting this menu option.

 After you pin the Excel 2013 option onto the Windows 7 Start menu, Windows 
adds a continuation button to the right of the menu item. Whenever you high-
light this menu item with a mouse (or tap it on a touchscreen), Windows 7 
automatically expands the Start menu to display a list of your recently opened 
Excel workbook files. You can then open one of these files for further editing 
at the same time you launch the Excel 2013 program simply by selecting its 
filename on the continuation menu.
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Pinning Excel 2013 to the 
Windows 7 taskbar
Instead of, or in addition to, pinning Excel 2013 to the Windows 7 Start menu, 
you can pin an Excel 2013 button to the Windows taskbar. 

All you do is drag and drop the Excel 2013 icon that either you pinned to the 
Windows Start menu or you added as a shortcut to the Windows desktop 
into its desired position on the Windows 7 taskbar. (See “Pinning Excel 2013 
to your Windows 7 Start menu” and “Adding an Excel 2013 shortcut to your 
Windows 7 desktop” earlier in this chapter for details.)

 After pinning a Microsoft Excel 2013 icon to the Windows 7 taskbar, the button 
appears on the Windows taskbar each time you start your computer, and 
you can launch the Excel program simply by single-clicking its icon with your 
mouse or tapping it with your finger or stylus on a touchscreen device.

Exiting Excel
When you’re ready to call it a day and quit Excel, you have a couple of 
choices for shutting down the program:

 ✓ Press Alt+F4 on your physical or virtual keyboard.

 ✓ Click or tap (on a touchscreen device) the Close button (the X) in the 
upper-right corner of the Excel program window. 

Quitting Excel 2013 on a touchscreen device
If you’re running Excel 2013 on a touchscreen 
device without a physical keyboard (even one 
with a relatively large screen like my 10-inch 
Acer Iconia tablet), for heaven’s sake, don’t 
forget to engage the Touch mode on the Quick 
Access toolbar (see “Customizing the Quick 
Access toolbar” earlier in this chapter for 
details). Turning on Touch mode sufficiently 
separates the Close button in the very upper-
right corner of the Excel screen from the 

Restore Down button to its immediate left so 
that when you tap the Close button, you end up 
actually exiting Excel rather than just shrinking 
the Excel program window on the Windows 
desktop! Also, if you have your virtual keyboard 
displayed in Excel and want to use the Alt+F4 
method for quitting the program, remember 
that you have to tap the Fn button to display the 
function keys before you tap Alt followed by F4.
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If you try to exit Excel after working on a workbook and you haven’t saved 
your latest changes, the program displays an alert box querying whether you 
want to save your changes. To save your changes before exiting, select the 
Save command button. (For detailed information on saving documents, see 
Chapter 2.) If you’ve just been playing around in the worksheet and don’t 
want to save your changes, you can abandon the document by selecting the 
Don’t Save button instead.

Help Is on the Way
You can get online help with Excel 2013 any time that you need it while using 
the program. Simply click the Help button (the button with the question mark 
icon to the immediate right of the Minimize the Ribbon button on the right 
side of the program window opposite the Ribbon’s tabs) or press F1 to open 
a separate Excel Help window. (See Figure 1-10.)

 

Figure 1-10: 
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When the Excel Help window opens, Excel attempts to use your Internet con-
nection to update its topics. The opening Excel Help window contains links 
that you can click to get information on what’s new in the program.

To get help with a particular command or function, use the Search Help text 
box at the top of the Excel Help window. Type keywords or a phrase describ-
ing your topic (such as “print preview” or “printing worksheets”) in this text 
box and then press Enter or click the Search button. The Excel Help window 
then presents a list of links to related help topics that you can click to display 
the information.

 To print the help topic displayed in the Excel Help window, select the Print 
button (with the printer icon) on its toolbar. Excel then opens a Print dialog 
box where you can select the printer and options to use in printing the 
information.
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